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INTRODUCTION 

Release Notes Avizo 7.0.0 

Release Date: December 2011 

This document describes the improvements and new features in version 7.0 of Avizo, the 3D visualization 
Software for Scientific and Industrial data. 
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OVERVIEW 

Avizo 7 is a major evolution of the Avizo product family including many enhancements of the user interface, 
more flexibility, simplified workflows and even more advanced algorithms.  

 

NEW PRODUCT IN AVIZO FAMILY: AVIZO XLAB EXTENSION 

XLab Hydro 

XLab Hydro is a new extension of Avizo Fire software, which provides numerical simulation capabilities to 
calculate absolute permeability of a porous media, from a scanned sample (CT, FIB/SEM, MRI, etc.). 
XLab Hydro directly computes material properties from the segmented 3D image. The Stokes equations are 
solved using a finite volume method, with no need to extract a 3D mesh (for Finite Element simulation) or a 
geometric skeleton (for Pore Network Modeling). 
 
 Two new modules are provided: 
 

• Absolute Permeability Experiment Simulation 
Simulation of an experiment, by hermetically closing a given sample on four faces while experimental setups 
are added on two opposite faces to guide the flow along one direction; 

• Absolute Permeability Tensor Calculation 
Calculation of the intrinsic permeability tensor, by imposing periodic boundary conditions on a 
representative elementary volume. 

The studied material must be composed of two parts: an impermeable solid phase and a void space in which an 
incompressible single phase fluid flows.  

See Avizo XLab User's Guide for more information. 
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AVIZO ALL EDITIONS - IMPROVEMENTS AND NEW FEATURES 

See also below in this document improvements and new features for specific Avizo Editions. 

NEW MODULE NAMES AND MENUS, TERMINOLOGY CHANGES, SCRIPT COMPATIBILITY  

New module names and menus  

One of the major changes in this release making learning and use of Avizo easier is the renaming of a number of 

Avizo modules. New names have been introduced for easier reading and understanding.   

Modules categories and menus have also been reorganized in order to find more quickly the needed features.  

Avizo users will find in the Avizo user's guide index tables for retrieving modules and menus based on former 

names. The tooltip displayed when holding the mouse over a module will remind the former module name if it 

differs more than only whitespaces.  

In this document the new and former module names are indicated as follows:  New Name (FormerName).  

New terminology: Avizo projects  

In order to avoid mix-up and make Avizo concepts easier to understand, the set of active data objects and 

connected modules is now preferably called Project instead of "object pool" or "module network". Therefore 

menus such as "Save Network" have been replaced by "Save Project". 

The "Pool" component is now called Project Graph View, and "Explorer" is called Project Tree View. Project View 

refers to both representations. 

In Avizo XPand programming interface, the project is still referred as the network or module network, or the 

object pool. The pool also refers to Avizo Project View, more specifically the Project graph View. 

Console commands and scripting compatibility  

Note that this section is only relevant for Avizo users using TCL commands or creating scripts. 

Many module names now contain whitespaces for easier reading in Avizo user interface and scripts. This has 

some impact on script commands. The module names which contain whitespaces can be written as follow in TCL 

commands and scripts:  

- “The Module” 
- The\ Module 
- {The Module} 

In the console, the automatic completion upon pressing TAB key will insert quotation marks. 

The compatibility is ensured with unmodified network scripts saved by former versions of Avizo (.hx files).   

For modified .hx scripts and for .scro scripts modules, some minor changes may be required: 

- Scripts that use hardcoded module names may require to be changed.  

Module names should be enclosed with quotes, for instance:  

             OrthoSlice sliceNumber setValue 10   becomes:  "Ortho Slice" sliceNumber setValue 10 
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- Instead of using hardcoded module names in script modules, it is highly recommended to store these in 

variables, for instance:   

              set myOrthoSlice [create HxOrthoSlice]; "$myOrthoSlice" sliceNumber setValue 10 

- $this should be enclose in quotes, for instance: "$this" proc constructor { }  

- For adding quotes within quoted strings, use '\' escape characters: 

            "$this" myButton setCmd 0    "\"$this\" showHistogram" 

- Note that TCL variables are not evaluated within curly brackets { }, for instance: 

            create HxOrthoSlice {$variable}  should be: create HxOrthoSlice "$variable" 

The Avizo XPand C++ programming interface is not affected by these changes. Object class names remain 

unchanged. 

NEW FEATURES 

New units management 

Powerful unit management has been introduced in Avizo 7. Avizo can now handle working units and display units 

for coordinates and spatial dimensions, which can be specified by user or retrieved from data for some file 

formats. For more details see Avizo user’s guide, chapter “Units in Avizo”.  

Note that Avizo Wind already handled units for physical quantities retrieved from solvers data files.  

New enhanced and simplified volume visualization modules  

replacing former Voltex, VoltexHighQuality and IsosurfaceRendering  

The new Volume Rendering module replaces the Voltex and VoltexHighQuality modules for rendering 3D image 

stacks. This module is much easier to use than the previous ones. Only useful settings are visible by default and 

an advanced mode gives the full control of the render settings.  

Similarly, the new Isosurface Rendering module replaces IsosurfaceRender for fast rendering of isosurfaces 

without actual geometric computation.  

A new Volume Rendering Settings module presents common settings used by VolumeRender and 

IsosurfaceRender. This module holds the actual input connection to data. 

Multiple Isosurface Rendering modules with different isovalues and colors can be attached to the same data, 

associated to a unique Volume Rendering Settings. However it is not possible to attach multiple Volume 

Rendering modules to the same data, as it was possible with former modules Voltex and VoltexHighQuality. As an 

alternative, you can create a Multi-Channel Field object (menu Create) to group multiple graylevel images of 

same size, possibly copies of the same data. Then the Volume Rendering module allows selecting and combining 

the different channels for display. 

You can attach to Volume Rendering Settings a module ROI Box for Volume Rendering, allowing flexible clipping 

combinations such as "corner cuts". 

Volume Rendering and Isosurface Rendering can now be picked in the 3D viewer, for instance after selecting a 

data probing module such as Point Probe and clicking on volume with middle mouse button,  or  when using Slice 

“fit to points” option,  or for selecting the display module by picking (new feature described below in this 

document). The picked point is set on the first non-transparent voxel.  

Note that, therefore, you cannot anymore pick or drag other objects such as OrthoSlice through volume as it was 

possible with VoltexHighQuality.  For this you can just select the display module and toggle off the new 

“pickable” button in the editors region of the properties area (see below “New display module option for 

picking”). 
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Note: The modules Voltex, VoltexHighQuality, IsosurfaceRender and LDMExpertSettings are now deprecated and 

no more exposed in modules menus. However these modules can still be created by scripts for compatibility. 

New Rendering Quality preferences  

New options are added in Preferences Rendering tab:  

- It is now possible to activate high precision frame buffer for rendering, which can dramatically improve volume 

rendering quality, in particular for large semi-transparent volumes. 

- An interactive rendering option has been added to activate simplified rendering while interacting in various 

places such as Volume Rendering and Isosurface modules. 

New module Extract Image  

The new Extract Image menu replaces the createImage TCL command available for planar modules such as Ortho 

Slice, Slice (ObliqueSlice, FilteredObliqueSlice), Curved Slice, Cylinder Slice and Image Ortho Projections 

(ProjectionView). It creates image data from the currently displayed slice. 

Point Probe callouts 

Point Probe module now supports customizable callouts.   

Note that new extended measure tools are now available in Avizo Fire Edition. See below in this document "New 

Measurement tools and module". 

New module Split Volume 

The new module Split Volume splits a mosaic (2D tiled images within a single slice) into a 3D image stack or multi-

stacked volume into separate stacks.  

New module Convex Hull  

This module Convex Hull allows you to compute an approximation of the convex hull of arbitrary point sets, line 

sets, surfaces or grids. The computed output is given as a triangulated surface. 

Support for JPEG 2000 image files  

JPEG 2000 image files are now supported for both input and output. 

 

USER INTERFACE ENHANCEMENTS 

Dockable windows, new toolbar and windows layout 

It is now possible to reorganize the Avizo windows layout by moving windows interactively: to detach a panel 

window drag its tittle bar. 

The Project View (Pool) and the Properties areas are now also in independent panels. It is also possible to hide or 

show these panels by using TCL commands: theProperties show/hide and theProjectView show/hide 
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A new toolbar provides a set of buttons for quick access to open, save, preferences, console, colormap editor, 

etc. The toolbar has buttons for showing/hiding all panels (hotkey Ctrl-F11) or help panel (hotkey Ctrl-F1). 

The Stop button is now next the progress and status bar, and is no more part of the Properties panel. The Close 

button for the Segmentation Editor is now located next to the Main Panel's top right buttons. 

Avizo editions are now distinguished by color symbol in menu bars.  

Note that the console is now hidden by default. You can use the top menu Window to show it or you can press 

the Console button in the toolbar. 

More tooltips 

Many tooltips providing short descriptions have been added for: 

- Ports 

- Module names in pop-up menus 

- Module in Project View, even when module is not selected 

- Editors 

Tooltips remind the former names of modules. 

New colormap editor 

The colormap editor has been redesigned for more convenient use. The new colormap editor user interface has a 

more compact layout and is dockable as other Avizo windows, so it can be more easily used permanently. A top 

window toolbar button allows showing or hiding the colormap editor. The colormap editor automatically selects 

the colormap depending on the selected data and display module. The opacity curve (alpha curve) is displayed 

overlaid on top the data histogram. You can translate easily opacity curve segments and set predefined curves. 

Color keys are now edited with the standard Avizo color editor, and saved to colormap files with exact matching 

data values. Two-side color keys can be defined for 'step' interpolation. 

All colormaps available from Avizo installation directory can know be accessed directly from the colormap editor. 

You can still load other colormaps in Avizo by the main menu File > Open Data. 

New Load File dialog 

The dialog used for opening and saving files are now implemented using native file dialogs. This allows you to 

benefit from all the system specific enhancements provided by the operating system. 

For overriding automatic format recognition, use the new item in main menu File > Open Data As… 

After selecting the file(s) to load, the Format selection dialog is displayed. 

Project View (Pool) enhancements – reorder icons, colormaps visibility, icon colors 

When working on a project with a large number of objects or when resizing windows, it is sometimes necessary 

to reorganize the icons displayed in the Project View (pool area). A new tool accessible in toolbar does it 

automatically. 

Colormaps connected to modules are now hidden by default to avoid confusing the project view. You can enable 

the option "Show colormaps connected to objects" from menu View>Preferences, in Layout tab, Project View 

box. 

The color of some icons has been lightened to enhance readability. Module icon color can be modified by using 

TCL option  –color in the module type resource description. 
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New display module option for picking  

When working on complex project where several modules can be tuned interactively by clicking on the3D view 

such as Ortho Slice, one could inadvertently make an unwanted change.  

Each display modules has now a new toggle button, in the editor region of the properties area, to make the 

module pickable or unpickable (locked for interaction in 3D viewer). Furthermore, the Project menu contains two 

new entries to make all display modules pickable or unpickable at once. 

Select a module from 3d view 

A new viewer tool allows you to select a module in the Project View by just picking on a visual representation in 

the 3D view. This is useful when several modules of the same type are displayed to select the right one. 

User interface for port connection  

The port connection mechanism, allowing connecting two ports so that when one is edited, the other is updated 

accordingly, was available only from the TCL scripting. This can now be done interactively: 

- Once a module is selected, click on its Connection Editor (large chain link icon) in the properties area to 

show connection buttons (smaller chain link icons) next to ports pin buttons.  

- Click on a connection button and drag it on top of a module containing same port to connect to. You can 

also connect with another port of same type in the properties area. 

- Right-click on a connection button to select the connected module or to disconnect the port. 

Note: corresponding TCL commands are now interconnect (formerly connect) and disconnect 

Synchronize module’s ports  

The new Synchronize Ports module can be used to synchronize at once all ports of two modules connected to its 

inputs. In order to use the module, select the first module to be synchronized. Then choose Animate>Synchronize 

Ports from the popup menu. 

Control object visibility per viewer  

 
A new toggle button "Link objects visibility" has been added to viewer's toolbar. When this toggle is on, changing 
visibility of an object will apply at once to all opened viewers.  
 
New convenience options have been added in viewer’s popup menu to control the visibility of display modules:  

- Display the same objects in the extra viewer (viewer id 4), 
- Hide all objects for the viewer, 
- Show all objects for the viewer, 
- Link the visibility of objects across all viewers (i.e. from viewer ids 0 to 5),  
- Copy the visibility status of objects from one viewer to another, 
- Display the viewer identifier in the viewer, 
- Display the viewer identifiers in all viewers. 

 

Data Info tags enhanced 

Data information tags can now be pinned in properties panel. 
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The displayed information has been clarified for image data types. Information on optional data window and 

range calibration (Avizo Fire edition only) is now also displayed. 

 

New range slider port user interface  

Range ports such as Ortho Slice's Data Window now allow dragging directly the range interval or boundaries. 

Note that Avizo Fire Edition can in addition display the data histogram in slider background. See below in this 

document "Slider histogram". 

Surface Editor's user interface clarified  

The selector tool of the surface editor has been enhanced for more clear usage. Test results are now displayed in 

the viewer in addition to the console. 

Height Map Field (HeighField) default draw style and scale changed  

For quicker display, the default draw style for Height Field Map module is now shaded instead of outline. The 

default scale is now -0.05 and port min/max allows negative and positive scales.  

 

FILE FORMATS ENHANCEMENTS 

New NSI reader 

A new reader for North Star Imaging data files has been added. 

Improved Large Data Access (LDA) support for RGBA color data 

The LDA format conversion and support modules such as Extract Subvolume (LatticeAccess) have been improved 

for support of RGBA color data. 

DICOM import improvement 

The DICOM reader does not anymore predefine a DataWindow parameter for the loaded data and an arbitrary 

default linear data mapping for the attached display modules.  

DataWindow was previously set to range [-200;200]. 

The DICOM reader has been extended to support more format variations. 

Note that Anonymize Image Stack module is now visible only when the dataset contains DICOM parameters. 

Improved support of Olympus OIB file format  

Olympus (oib/oif) reader fixes several issues regarding version 2 of the file format. 

Export to Open Inventor compressed format 
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It is now possible to save Open Inventor data as binary compressed format using the Open Inventor 8.x file 

format. 

NOTE: Avizo now exports Open Inventor format version 8.6.  

New Avizo data file format 

Avizo’s native data files are now identified as such and use a new header format (# Avizo …), superseding the 

former name AmiraMesh for container format. Avizo is however still compatible with the same data files as its 

previous versions: Avizo can write data files using Avizo 6 file format, and can read the same AmiraMesh data 

files as the previous Avizo version. 

Extended support for international characters in file paths (e.g. Chinese or Japanese)  

File paths with international characters are now supported for the following formats: IGES, STEP; Avizo native 

format for images, grids and surfaces; DICOM, RAW and TIFF. Other file formats may still not be supported for 

international file paths. 

 

OTHER ENHANCEMENTS 

Enhanced MATLAB integration 

The connection to the MATLAB server has been improved. The Calculus MATLAB module can now transfer 

surfaces, surface fields, and line sets between Avizo and MATLAB through struct arrays. Lattice data - such as 

images or regular scalar fields - can now also be passed as struct arrays, enabling access to information such as 

bounding box (i.e. voxel size). 

You can now even attach any type of module as input to Calculus MATLAB.  The module’s ports will be sent over 

to MATLAB and made available in a struct array named after the input module. This provides a way to transmit 

information like text strings or parameters from Avizo to MATLAB. 

Also, Calculus MATLAB can now be accessed directly from the Create menu and therefore does not require to be 

attached to a field anymore. 

New tutorial examples using MATLAB have been added: core line detection, conversion from RGB to CIE Lab color 

space, and image denoising. 

Enhanced Spreadsheet support  

A new module Spreadsheet Filter allows filtering a spreadsheet by the data values of up to four user defined 

columns. Filtering can be performed by setting an upper and lower threshold or by an arithmetic expression.  

Rows can now be added or removed dynamically in spreadsheets. 

The module Plot Spreadsheet can now display a marker line. The marker line position is controlled by a time 

input port that can be connected to another module with time port for synchronization.  

This replaces the deprecated module Time History Plot that can be still created by script for compatibility. 

Save project (module network) from TCL script 
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The new TCL commands saveProject and saveProjectAs can be used to save a project (module network) from a 

TCL script. 

Vertex View 

If this module is connected to a line set, a new port allows selecting a line set's data field for coloring. 

A new DrawStyle option Haze has been added which enables a star-like effect. 

Stream LIC Surface (SurfaceLIC) 

The Stream LIC Surface module has now the possibility to use two color fields. This second optional scalar field 

adds the option to colorize the LIC with the two fields multiplied. 

Scalebars (Scale) 

The Scalebars (Create > Scale) display module has two new options to set the line width of scale bars and the font 

size of graduation. 

Display Time and Display Time new Font port  

A new port is available for changing font name and size for Display Time and Display Date modules. 

Enhanced Surface Patch Contours (DisplayContour) 

The Surface Patch Contours (DisplayContours) module has been extended in order to choose contours according 

to their bordering materials. 

Isocontour Slice (Isolines): new port Quality  

A new port has been added to control the sampling used by Isocontours Slice. 

Probing and Arithmetic on external data 

Probing tools and Arithmetic modules are now working on external data (read as External Disk Data). 

Enhanced Surface Cross Section (SurfaceCut) 

The Surface Cross Section (SurfaceCut) module can now use a constant color for rendering materials. 

Color Wash color blending 

The Color Wash module has a new fusion method Label Blending to blend the label colors. It uses alpha blending 

to blend in each voxel of the attached label field, colored by its material color as specified in the bundle 

parameter. 

Slice module (ObliqueSlice, FilteredObliqueSlice ) enhancements 

The Slice module (formerly FilteredObliqueSlice) now supersedes ObliqueSlice.  
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New filters have been added: morphological opening and closing filters, Non-Local Means filter. 

The Apply buttons and auto-refresh can now be used to control computation of filter. For instance, you can set 

auto-refresh toggle off to avoid the computation of edge preserving smoothing filter whenever changing one of 

its parameters. By default auto-refresh is on, expect for the Non-Local Means filter available with Avizo Fire 

edition. 

Clipping Plane (ArbitraryCut) enhancement 

It is now possible to adjust the plane orientation of a Clipping Plane (ArbitraryCut)  or a derived module such as 

Slice (Oblique Slice) or Stream LIC Slice (PlanarLIC), based on a vertex set attached as input (Point Cluster, Surface, 

etc.). 

Curved Slice extension 

ROI planes can now restrict data extraction between two planes orthogonal to the slice direction. 

Point list edition enhanced in curve editor and data probing modules  

The 3D point list port has a new Interactive option to see the shape of the segment being drawn before 

appending a new point to the curve. 

Isosurface downsampling 

When interactive rendering option is set in Preferences > Rendering, Isosurface is automatically downsampled 

while moving the slider when auto-refresh is set. 

Segmentation Editor enhancements  

Note that the Close button for the Segmentation Editor is now a small cross button located next to the Main 

Panel's top right buttons. 

A question mark button has been added at top the of the Segmentation Editor panel for direct access to the related 

help. Tooltips are also displayed when hovering the mouse over panel buttons.  

The default draw style for labels is now hatched. You can now change the default draw style for labels in the 

Preferences>Segmentation tab. 

You can now change the Image to be segmented at the top of the Segmentation Editor panel. 

Multiple label fields can now be used in the segmentation editor. It is now possible to create a new empty Label 

field to be edited, to delete the currently edited Label field, or to choose a Label field to be used from within the 

segmentation editor. 

New buttons for morphological erosion and dilation have been added beside selection tools.  

New buttons for adding, removing or locating materials have been added next to materials list. 

For convenience, thresholding is now available in Tool’s toolbar instead of Selection menu. 

The brush tool is now more responsive when quickly moving it. 
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It is now possible to change the upper bound of the size slider of the brush tool. This can be used to select discs 

of arbitrary size.  

TCL commands have been added: 

- lockMaterial: to lock the current material 
- isMaterialLocked: to inquire if the current material is locked 
- newMaterial: to create a new material 
- renameMaterial: to rename the current material. 

 
See also below in Avizo Fire Edition other important enhancements in the segmentation editor. 

Snapshot tool 

It is now possible to capture all viewers in a snapshot.  

You can also configure printer when choosing printer output for snapshot. 

 

The snapshot tool now allows exporting images in pdf format. 

TCL upgrade 

Avizo now uses TCL 8.5. 

Open Inventor upgrade 

Avizo now uses Open Inventor 8.6.2 as graphics engine. 

 

PERFORMANCE IMPROVEMENTS 

Control of multi core usage  

It is now possible to control the maximum number of CPU threads usable by compute modules. By default this 

value is set to "Automatically choose number of threads". A new Performance tab has been added to the 

preference editor for this parameter. 

However note that multi-core usage by Quantification module in Avizo Fire is still controlled by the command 

Quantification:parallelmode. 

Resample 

The Resample compute module has been enhanced to take advantage of multi CPU systems. The performance 

gain is approximately proportional to the number of CPUs available. 

Erosion and Dilation 

The Erosion and Dilation morphological operators have been enhanced to take advantage of multi CPU systems. 

The performance gain is approximately proportional to the number of CPUs available. 
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Segmentation Editor threshold computation and 3D selection 

The threshold algorithms and the 3D selection display of the segmentation editor have been enhanced to take 

advantage of multi CPU systems. The performance gain is approximately proportional to the number of CPUs 

available. 

Faster histogram computation 

The histogram computation has been enhanced to take advantage of multi CPU systems. The performance gain is 

approximately proportional to the number of CPUs available. The histogram computation is used in several Avizo 

tools like for instance when launching the segmentation editor.  

Improved performance of Movie Player 

Performances of the Movie Player module have been improved significantly by using recent GPU hardware 

acceleration when possible. 

Improved Large Data Access (LDA) conversion performances  

Conversion performance has been improved for stacks of 2D images, in particular for large images.  
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AVIZO FIRE EDITION - IMPROVEMENTS AND NEW FEATURES 

See also above in this document the improvements and new features common to all Avizo Editions. 

NEW FEATURES 

New automatic range calibration  

When loading 3D image data, the new automatic intensity range calibration tool computes a set of values 

representing possible threshold between phases in the data set based on a gradient method. The set of values 

(so called calibration ranges) are then directly usable in all modules having a threshold value slider port, or 

colormap port, such as Isosurface, Ortho Slice, or Volume Rendering.  

A new Preferences tab Range Calibration allows controlling this feature. 

New Ortho Views display module 

The new Ortho Views module displays a 3D image data set or, more precisely, a 3D scalar field with either 

uniform or stacked coordinates, in four views: one full 3D view and 3 side views of the xz, yz and xy planes. This 

module replaces the former StandardView module which was limited to 2D representations in side views. In 

Ortho Views, any 3D modules can be displayed in all views. Furthermore, from the Ortho Views module, several 

overlay modules can be attached such as Isocontour Slice (Isoline), Surface Cross Section (SurfaceCut), or Surface 

Cross Contour (Intersect), to easily overwrite the default representation.  

A convenience template menu is available for easy setup of visualization for 3D images (uniform scalar fields, 

color fields, or LDA on-disk volume data). You can access it from data object menu Template. This menu setups 

range calibration on data if needed, and attaches an Ortho Views module with Calibration View (contours) and a 

Volume Rendering module. 

New Measurement tools and module  

The Measurement tools available in viewer window and the associated module have been changed in Avizo Fire 

edition. The new tools allow snapping of anchor points to high or low image grey or gradient intensities (edges) 

or nearest points of linesets. The snap area size can be defined by user. Customizable callouts can now be 

attached to measures. The angle and circle manipulators have been enhanced. The new Measurement module is 

now fully scriptable. 

Note that 2D measures tools previously available are now superseded by 3D measures. 

The previous Measurement module - as available in Avizo standard edition – is no more exposed in Avizo Fire 

edition but can be still created by script for compatibility.  

New Porosities Analysis Wizard  

The new Porosities Analysis Wizard module is a workflow assistant that allows quickly extracting and 

quantitatively analysing porosities in a 3D image.  

New FIB Stack Wizard  
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The new FIB Stack Wizard module is a workflow assistant for shear correction, automatic alignment, shading 

correction and cropping of image stacks coming from FIB/SEM acquisition (Focused Ion Beam / Scanning Electron 

Microscope). 

New morphological Opening and Closing image filter  

New morphological filters Opening and Closing have been added to image filter editors. 

New Non-Local Means image filter  

The new Non-Local Means filter is a very powerful tool for removing noise such as white noise from an image. 

The non-local means algorithm will naturally preserve most features present in the image, even small and thin 

ones. This module is accelerated by multi-core or GPU. 

Note that in the Slice module, the auto-refresh toggle is off by default for the Non-Local Means filter. 

 

New Anisotropic Diffusion image filter  

The new Anisotropic Diffusion filter module is a very powerful tool for enhancing noisy or non-uniform images for 

purpose of segmentation. Similar to the Edge Preserving smoothing filter, this module is accelerated by multi-

core or GPU.  

Unlike the Edge Preserving filter, the Anisotropic Diffusion filter always applies in 3D mode only and cannot be 

applied by slice in the current release. It is therefore not available in Slice filters. 

Simplified handling of label fields/images  

Visilog label images and binary images, as created by modules such as Quantification, are now standard Avizo 

label fields. Avizo label fields can now store 16 and 32 bits labels. 

Note however that a number of modules in Avizo 7 will still only accept 8-bits labels.  

The segmentation editor can accept 16/32 bits labels if they contain less than 256 labels.  

The module Convert Image Type (CastField) and a new in-place editor allow converting 16/32 bits labels. 

New watershed tool in the segmentation editor  

 
The new watershed tool is a powerful addition to the segmentation editor. This tool allows taking best advantage 
of Avizo Fire Watershed Algorithm with interactive techniques for effective segmentation of complex 3D 
structures. It is based on a marker-controlled watershed algorithm which segments a grey level image based on:  

- A landscape image, for instance gradient extracted from the dataset. 
- A set of markers identifying seed regions, for instance defined from the current selection or by selected 

materials already segmented. 

Region growing threshold in the segmentation editor  

Region growing tool of the segmentation editor’s magic wand can now be limited to a contrast threshold defined 

by a slider. 
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Slider histogram  

Slider ports representing a threshold and used for instance in Isosurface, Multi-Thresholding (LabelVoxel), 

Ortho Slice, etc., display now the data histogram in the background. This is useful for identifying representative 

threshold values. 

Thresholding RGB color images with Interactive Thresholding (Quantification-Threshold) 

The Interactive Thresholding module (Quantification-Threshold) can be now be attached to color fields and 

allows defining minimum/maximum thresholds for each of the three RGB channels.  

Float slider in Interactive Thresholding ( Quantification-Threshold) 

When working on image containing floats or doubles, the Interactive Thresholding (Quantification-Threshold) 

threshold slider ports now display float values. 

Visilog colormaps replaced by standard cyclic colormaps  

The specific colormaps used for instance for label images or binary images created by the Quantification module, 

are now replaced by standard colormaps labels and labelsBinary. These colormaps use new properties for cyclic 

colors and for preventing color interpolation across values. 

 

QUANTIFICATION MODULE NEW FEATURES AND ENHANCEMENTS 

New image filtering commands in Quantification module  

 New adaptive filter command group: bilateralfilter, bilateralfilter3d, despecklefilter, despecklefilter3d, 

nagaofilter, nagmodfilter3d, sigmafilter, sigmafilter3d, snnfilter, snnfilter3d (SNN: Symmetric Nearest 

Neighbor). These non-stationary filters are used to reduce image noise while preserving maximum contours. 

Note: see also Avizo Fire Anisotropic Diffusion and Non-Local Mean image filters. 

 New commands: majorityfilter, majorityfilter3d. The majority filter replaces each pixel value by the most 

present value in its neighborhood.  

 New command gaussianfilter3d: a 3D Gaussian filter has been added, plus it allows to parameter smoothing 

factor depending on axis.  

 New color filter command:  antialiasing, a high performance filter for color images, used in demosaicing 

operations done on the raw images obtained from single-CCD color camera (Bayer filter). 

 New commands linearkernel1, linearkernel2 apply a convolution in a specific direction. Applies only in 2D.  

New and enhanced global measurements  in Quantification module 

 

 New command statmask to compute statistics only on the areas described by a binary image. 

 New command distmask to produce a distance map restrained by forbidden areas defined by a binary image 
mask. 

 inertia3d global measure now provides the secondary orientation. For instance in the case of a planar shape, 
this corresponds to its normal.  

 New command measurefilter to sort and filter connected components (labels) according to a measurement. 
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 New command volumedentisity2d, volumedensity3d for creating density images (map of density per volume 
unit).  
 

New and enhanced individual measurements  in Quantification module 

 

 New set of individual 2D measures related to co-occurrence matrices (texture measures) 

 New set of individual measures related to histograms of intensities present in the labels 

 New greybarycenterZ measure: Z coordinate of the weighted center of gravity.  Only X and Y were available 
in previous version. 

 Change in I_filter_image command: when input is a binary image, output is now a binary image. 

 EqDiameter measure now applies in 3D  

 New individual measure symmetry (indicator for shape symmetry) – 2D only. 
 

New and enhanced image processing commands in Quantification module  

 

 New command auto_threshold_inv : which corresponds to the sequence of commands 
auto_threshold and logical_not but in a single pass 

 New command auto_segment: similar to auto_threshold, but computes 2-level thresholds based on 
histogram. 

 Change in command hole_fill on 3D images: it can now directly apply either in 2D (slice by slice) or in 3D 

 New command border_fill 

 New command I_analyzeseq : similar to I_analyze but processing input as image sequences 

 New command cooccurrence (Segmentation /Texture group). 

 New commands removemeasurefromgroup, removegroup. 

 The command porosity can now operate slice by slice on image stacks 

 The command hysteresis can now apply in 3D  

 New command ridgelineimg similar to the ridgeline command but that generates a binary image as output 
instead of a segment object. 

 Change in bkgimg, shading_cor and ridgeline. The mask image can now be replaced by an empty string when 
the whole picture must be taken into account (instead of 0). 

 New command rotatecenter to rotate about the center of the image 

 New commands buildline2d,   buildline3d to create binary images with oriented parallel lines 

 New command zoomfactor to expand the image of a multiplicative factor 

 The command I_tophat now displays the unmodified input data as background image during interactive 
thresholding, instead of the result of closing or opening. 

Other Quantification module enhancement  

 

A new port Interpretation has been added to easily apply commands slice by slices (XY planes) or in all directions 
at once (3D), when applicable. This supersedes the seqfrom3d and seqto3d commands. 
 

Tooltips are now displayed when hovering over inputs in the 'pipeline' area of the Quantification module's 
properties. 



 

18 
Avizo 7.0 release notes – VSG© 2011 

PERFORMANCE IMPROVEMENTS 

Optimized processing in Quantification module commands  

 
Optimizations enable significant gains on most Quantification commands, both in mono and multi processors and 
in 2D or 3D.  In a number of cases performance gains up to 50% or above have been achieved. 
 
In particular, performance has been improved in a number of cases for Gaussian and median filters commands, 
and for fastwatershed and derived commands like binseparate or greyseparate. 
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AVIZO WIND EDITION - IMPROVEMENTS AND NEW FEATURES 

See also above in this document the improvements and new features common to all Avizo Editions. 

NEW FEATURES 

New features for time series  

The Sequence Controller module now allows extracting separate time steps, without duplicating model data. 

New Pathline module 

The new Pathline module extracts the path of massless particles inside time-dependent 3D vector fields. 

Improved support for mechanical data  

Support has been added for mechanical data stored at element nodes, such as stress and strain. 

New Tensor Extract compute module  

The new Tensor Extract module computes tensor related variables such as the invariants, the eigenvalues, and 

the eigenvectors. It also computes from the stress tensors the Von Mises and Tresca elasticity limit criteria. 

New displacement scale factor  

A displacement scale factor has been added to the Sequence Controller in order to magnify or minimize the 

deformation of the mesh displacement. 

New Bar Chart Slice module  

A new Bar Chart Slice module displays an extruded plane slice of a scalar field attached to an unstructured mesh 

model. That is similar to Bar Chart Slice (CityPlot) or Height Map Slice (HeightField) modules already available for 

regular scalar fields. 

 

PERFORMANCE IMPROVEMENTS 

CFD/CAE file reader improvement 

The loading time for most CFD/CAE file formats has been divided by two. 
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AVIZO GREEN EDITION 

Support of NetCDF4 CF1 and relaxed compliance check 

NetCFD 4 CF1 is now supported. Compliance checking has been relaxed to allow importing more of the netCDF 

files that are not compliant with CF1 standard. 

Support of unstructured grid for NetCDF4 file format  

NetCFD support has been extended for unstructured meshes: Avizo Green can now support meshes unstructured 

in XY plane and structured in Z with cells composed of 3, 4 or 6 vertices, considered conformal. A number of 

representations have been extended for this type of mesh: Cross Section (unprojected in projected space), 

Vectors Slice (Vectors), Isocontour Slice (IsoLines), Illuminated Streamlines (DisplayISL), Particle PahtLines, 

Isosurfaces, Embossed Slice (BumpSlice), Height Map Slice (CityPlot) 

AVIZO XPAND 

XPand now compatible with Qt LGPL  

The XPand extension SDK can now be used with the Qt LGPL version in order to develop extension modules for 

Avizo. It is no more necessary to use the Qt commercial license for that. Avizo uses Qt-4.7.2. 

XPand for Windows and Visual Studio 9  

The XPand SDK is now provided for Visual Studio 2008 (VC9).  

New XPand examples for CUDA or OpenCL compute modules  

New tutorials and examples show how to create Avizo compute modules taking advantage of GPU using CUDA or 

OpenCL. 

XPand header files renamed  

XPand include files have been renamed. Amira is replaced by hxcore. A compatibility mode allows existing 

modules to compile without error. 

XPand menus - Programmer's Guide and Reference, Development Wizard, Qt Inspector  

XPand API Programmer's Reference can now be accessed from Avizo Help menu, in addition to Programmer's 

Guide. Do not miss also the Avizo Code Book, located in the "doc" subdirectory of the Avizo installation directory. 

The Development Wizard can be accessed from the XPand menu. A new Qt Widget Inspector is also available in 

this menu. 
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LIST OF SOLVED ISSUES 

 

Issue# Title Release notes 

62 Saving an imported file to Avizo unstructured mesh format is 
not possible 

When loading a simulation result such as a Fluent 
file, it was not possible to save the data as an 
Avizo model. 

274 TimeSeriesControl "interpolate between frames" do not 
work in some cases 

Standard demo Avizo/Time-Dependent Data/ 
"Argon cluster" did not work when "interpolate 
between frame" is checked. 

318 TimeHistoryPlot should not be in Main menu for 
spreadsheet objects 

AVIZO ALL EDITIONS - OTHER ENHANCEMENTS  
The module Plot Spreadsheet can now display a 
marker line. The marker line position is controlled 
by a time input port that can be connected to 
another module with time port for 
synchronization.  
This replaces the deprecated module Time History 
Plot that can be still created by script for 
compatibility. 

414 Display modules help page says there is a Colormap port but 
it does not appear in the user interface in Avizo Wind 

In Avizo Wind, when an unstructured model is 
displayed, the colormap does not appear in the 
display module ports because the colormap is 
contained in the data set. The documentation has 
been updated to explain this behavior. 

510 Shortcut F1 doesn't work on editors dialogs When an editor floating dialog boxes is active, 
pressing F1 will now display the help page of the 
corresponding editor. 

571 Bounding box of an extracted surface is too big Bounding box does not include any more unused 
points that may be contained in a surface data 
object. 

608 Some SEGY file crashed with Avizo Earth SEGY wizard Fixed. 

674 Quantification: I_tophat command should display threshold 
on original data 

Fixed. Tophat is applied to segment adaptively 
local features by thresholding the difference of 
the input image and its morphological closing or 
opening. The final interactive thresholding is now 
displayed on top of the original input image, 
which is much easier to interpret. 

799 Erroneous example for tracker manual calibration The tracker coordinates were given in decimeter 
instead of meter despite the comment "tracker 
coordinates reported in meters". The tracker 
coordinates were given with a tracker origin in 
the left/bottom of the screen instead of the 
written center/bottom. 

829 VoltexHighQuality doesn't work on data set with double as 
data type. 

This is now solved with Volume Rendering 
module. 

832 LoadCmd doesn't store CSV Uniform Scalar Field 
parameters. 

Fixed. This was preventing to reload network with 
uniform scalar field data in CSV format. 

1150 Isosurface color field not updated in some cases Fixed. When an Isosurface was colored with 
another field as color field, after some changes of 
the color field, the display was not updated 
correctly. 

1233 ObjectRotate with netCDF data does not work with 
DemoMaker and attached MovieMaker 

Fixed. ObjectRotate did not rotate until a new 
time step was loaded by netCDF controller. 
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1251 AffineRegistration: missing documentation for some module 
ports 

Documentation has been completed. 

1252 DisplayISL: distribution mode documentation must be 
improved 

Documentation has been completed. 

1306 Parameter editor: missing bundle value on label fields Fixed. The Parameter editor now displays the 
bundle index, indicating the label value for the 
corresponding material. 

1307 LineSet getPoint function not well documented Fixed. When used with no argument, the function 
getPoint now returns the regular usage. 

1387 IsosurfaceRendering cannot be displayed in only one viewer 
pane 

This is now solved when using new Isosurface 
Rendering module, which can be made visible or 
invisible independently on multiple viewers. The 
former IsosurfaceRendering module could be 
visible or invisible only on all viewers at once. 

1436 Quantification: auto_threshold command lack 
documentation for available methods 

Documentation has been completed for the 
different algorithm methods: entropy, 
factorization (Otsu), moments. 

1437 Isosurface won't update after pushing the apply button if 
only dataset changed 

Fixed. Isosurface didn't update after pushing the 
apply button if a transformation has been applied 
to the dataset. 

1463 IsosurfaceRender: incorrect display with 2 viewers This is now solved with new Isosurface Rendering. 

1476 VoltexHighQuality fails to display the double precision data This is now solved with Volume Rendering 
module. 

1512 Segmentation Editor: closing dialog is annoying Fixed. The confirmation dialog warning about 
possible loss of selection when closing the 
Segmentation Editor is no more displayed after 
selection has been cleared. 

1517 Color Dialog predefined color selection is too complicated To select a predefined color, the user had to drag 
and drop from Custom Colors to the Current Color 
box. 
A simple click can now be used to select a custom 
color, or to undo change with Old Color. 

1573 LabelVoxel doesn't describe the supported formats and data 
type 

Documentation now specifies that LabelVoxel 
(Multi-Thresholding) doesn't support Uniform 
Scalar Field with float values. 

1710 Leica/lif export builds invalid am file Fixed. After loading a Leica/lif file in Avizo and 
saving it in .am format, it was not possible to 
reload the saved .am file. A message "... syntax 
error  ... Couldn't read..." was issued. This is 
because "." dot characters were not supported in 
data parameter name, such as used in some 
Leica/lif metadata. Dot character is now 
supported in data parameter names and Avizo 
files using these are no more invalid. 

1826 Avizo Wind license prevents from loading/displaying 
network using IDEAS time series with topology changes 

The Avizo Wind IDEAS reader is different from the 
Avizo Standard one. The Avizo Wind one does not 
support topology changes. Now, when IDEAS files 
are loaded as time series, the Wind Edition reader 
is used first. If it fails (because of topology 
changes), then the Standard Edition reader is 
used. 
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1936 Can't open IGES or STEP files in a directory path with 
international characters (e.g. chinese) 

(AVIZO ALL EDITIONS - IMPROVEMENTS AND 
NEW FEATURES 
FILE FORMATS ENHANCEMENTS) 
 
Extended support for international characters in 
file paths (e.g. Chinese or Japanese) 
 
File paths with international characters are now 
supported for the following formats: IGES, STEP; 
Avizo native format for images, grids and 
surfaces; DICOM, RAW and TIFF. Other files 
formats may still not support international file 
paths. 

1947 No direct access in the Segmentation Editor to the related 
help 

A question mark button has been added at top of 
the Segmentation Editor pane for direct access to 
the related help. Tooltips have also been added. 

2042 Some DICOM files were incorrectly read Fixed. In some case DICOM with lossless jpeg 
compression was incorrectly read (white lines 
appeared). 

2047 Crash during LDA conversion of RGB files Fixed. 

2052 FilteredObliqueSlice do not show all the available filters AVIZO ALL EDITIONS - IMPROVEMENTS AND NEW 
FEATURES 
New filters have been added: morphological 
opening and closing filters, Non-Local Means 
filter. 

2060 Missing list of Avizo modules that require OpenMP Avizo systems requirements now include the 
following note.  
Important note: Avizo is linked with OpenMP 
libraries to effectively use multiple processors. In 
order to be able to link your Avizo XPand Pack 
developments in Debug mode, at least the 
Microsoft Visual Studio 2008 Professional edition 
should be installed (i.e. Microsoft Visual Studio 
Express and Standard editions do not provide 
OpenMP libraries.)  

2080 MovieMaker fails to export movies when starting Avizo with 
the option -no_gui 

Fixed. Avizo now supports batch off-screen movie 
generation. 

2130 Missing important note in System Requirements for using 
MATLAB 

MATLAB module documentation has been 
completed for installation. 

2256 OrthoSlice: binary transparency option considered as 
delayed, incompatible with some viewer transparency mode 

Fixed. Rendering of OrthoSlice with 'binary 
transparency' option was incorrect when using 
Sorted Layers Delayed transparency mode 
(View>Transparency menu). 

2257 Landmark can be "auto-picked" Fixed. When adding landmarks with Landmark 
editor, already added landmarks cannot be picked 
anymore for new landmark location. 

2339 OrthoSlice and other slice modules: "adjust view" option 
adjust the view in all viewers 

Fixed. Now only the active viewer (white frame) 
changes its view orientation to match the 
changed slice orientation. 

2369 Invalid input voxel size displayed in the Resample properties 
(precision not matching input data). 

Voxel size is now displayed with correct precision. 

2429 Bad export of vector or tensor fields in Matlab Fixed. When exporting a vector field or a tensor 
field, the components in the .mat file were not in 
the correct order. 

2581 CSV Point Cluster reader loses decimals Fixed. The CSV format importer was losing 
decimals when reading floating point values. 
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2666 Default draw style for labels in segmentation editor should 
be hatched or dotted 

AVIZO ALL EDITIONS - OTHER ENHANCEMENTS 
Segmentation Editor enhancements 
The default draw style for labels is now hatched. 
You can now change the default draw style for 
labels in the Preferences>Segmentation tab. 

2986 CastField (Convert Image Type) uses last scale set for 
converting to labels 

Even if scale port was hidden, the last scale set 
was applied. Scaling is no more applied when 
converting to label field. 

3017 Camera trackball must be off by default Camera trackball was inconvenient in a number of 
cases especially when using multi-viewer layouts. 
It is now hidden by default. You may still enable 
camera trackball using Preferences or viewer's 
right-click menu. 

      

639 VoltexHighQuality crash after disabling then re-enabling raw 
stereo 

This is solved with new Volume Rendering module 
superseding VoltexHighQuality. 

1214 Colormap Icon in Tree view not always displayedt The colormap icons in the third column of tree 
view (Show Extended TreeView) were sometimes 
displayed and sometimes not. 

1724 Avizo 6.3.1 standard package does not contain shortcut 
AvizoWind.app on Mac 

Mac installer has been fixed. 

1738 MacX links to Avizo applications missing Mac installer has been fixed. 

2376 SurfaceView does not render correct colors on some 
hardware 

On some hardware such as Mac win ATI graphics 
card or PC with Intel graphics card, SurfaceView 
displayed wrong uniform color on surface instead 
of different colors per material. This is no more 
reproduced with Avizo 7. 

2377 On Mac, Avizo 6.3.1 pkg doesn't install Avizo.app and 
corrupts Avizo.app from already installed Avizo version 

Fixed. 

532 VoltexHighQuality does not support Visilog labels colormaps AVIZO FIRE EDITION - IMPROVEMENTS AND NEW 
FEATURES 
Visilog colormaps replaced by standard cyclic 
colormaps  
The specific colormaps used for instance for label 
images or binary images created by the 
Quantification module, are now replaced by 
standard colormaps labels and labelsBinary. 
These colormaps use new properties for cyclic 
colors and for preventing color interpolation 
across values. 

540 Increasing number of slices of VoltexHighQuality make them 
disappear 

This is now solved by using the new option "Use 
high precision frame buffer" added in the 
Rendering tab of the Preferences dialog 
(accessible from menu Edit>Preferences). 

568 Some TIFF image can't be displayed correctly TIFF reader has been enhanced. 

599 The console command "setStereo -b" doesn't update the 
Stereo Preferences dialog 

Now "Zero Parallax Balance" and "Camera Offset" 
and the slider positions are updated 

631 AlignSlice menu "Options/Fix reference" not updated after 
running the setFixedReference TCL command 

Fixed. When using TCL command 
setFixedReference, the menu is now updated 
accordingly. 

633 Segmentation editor brush tool slower than in previous 
versions 

You could easily have "holes" when moving 
quickly brush tool in segmentation editor. The 
brush tool is now much more responsive. 

636 Snapshot dialog: when pressing Browse another filename 
extension is added to the existing one 

Fixed. In the "File name" field of the Save File 
dialog one could read filename.jpg.jpg 
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668 Segmentation editor: magic wand "All slices" option clears 
current selection in some cases 

Fixed. Magic wand "All slices" option cleared the 
current selection when the range of the magic 
wand scrollbar was out of the min/max range of 
the image. 

775 Line and SplineProbePlot-Object attributes should not be 
reset 

Fixed. Line and SplineProbePlot-Object attributes 
were reinitialized to default values when changing 
the orientation port of the probe. 

795 Snapshot doesn't support multi-viewers display This is now supported. Only the current view was 
exported. It is now possible to specify option 
"Capture all viewers". 

1156 System Info save report doesn't save CPU info It only saved OpenGL information. Now it saves 
also CPU information. 

1160 File browser very slow when opening a directory on the 
network with a lot of files 

Opening a remote directory with 8000 jpeg files 
took 100 seconds (Windows explorer takes 1 
second). 
The new file dialog fixes the problem since it uses 
the native implementation. 

1221 Opening time series failure when loading Tetra or HexaGrid 
with data field 

Fixed. Time Series Control module was not 
created and only the first time step data 
appeared in the pool. 

1224 GridCut: Translate port is reset when connecting the module 
to a new dataset 

This port now remains unchanged when the data 
set connection changes. 

1270 No animation when enabling the option "interpolate 
between frame" of TimeSeriesControl 

Fixed. There was a specific issue related to some 
modules such as Isosurface. 

1370 No helpful message and sometimes crash when Avizo fails to 
load a stack of images 

Fixed. In some cases, when loading data larger 
than available memory, a message was displayed 
in the console "could not allocate xxx bytes". 
Then Avizo could crash, or create incomplete data 
object without warning.  
Now a clear warning message is displayed, and 
Avizo will not try to allocate or load data larger 
than available memory. 

1385 Undocumented module Display>BoundaryIDs BoundaryIDs was the counterpart of tetra grid 
BoundaryConditions for hexa grids. This module is 
now also documented (new name is "Boundary 
Conditions"). 

1386 Quantification module command persistence broken Fixed. Unexpected changes in Quantification 
module names in some cases. It prevented to 
reload saved module networks. 

1388 NetCDF reader is too restrictive Compliance checking is now relaxed for NetCDF 
reader. A netcdf file that matches the Climate and 
Forecast (CF) Metadata Conventions version 1.0 
couldn't be loaded in Avizo Green if ":Conventions 
= "CF-1.0" ;" was not found in the header. Now a 
warning is simply displayed. 

1413 am reader doesn't support dot characters in material names Fixed. Dot "." character can now be used in 
material names. 

1534 MovieMaker doesn't support exports to filenames on the 
network 

MovieMaker can now use network file paths. 

1566 Viewer snapshot console command failure when using the 
option -offscreen 

The console command "viewer snapshot -
offscreen 1400 1024 test.jpg" returned the error 
"-offscreen: unknown format". "viewer snapshot -
offscreen ..." now works for making a snapshot of 
multi-viewers layout. For a single viewer use 
"viewer 0 snapshot -offscreen ...". Note that the 
viewer's snapshot button and dialog box now also 
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allows creating snapshots of either single viewer 
or multi-viewers layout, optionally offscreen with 
specified size.  

1595 Abaqus export doesn't store materials of exported surfaces Fixed. Abaqus files are now exported with all 
materials. 

1712 Interpolation of lasso selection in segmentation editor 
prevents from selecting voxels at the edge of the slices 

The first and last slices have all voxels selected 
but the interpolated selection missed some voxels 

1767 Brush tool of the segmentation editor selects less areas 
since Avizo 5.1 (when moved too quickly) 

You could easily have "holes" when moving 
quickly brush tool in segmentation editor. The 
brush tool is now much more responsive. 

1884 Changing the object name in Image Read Parameters dialog 
has no effect 

The Image Read Parameter dialog now allows 
setting the name of the object created in the 
pool/project. 

673 Equalize filter and OrthoSlice with histogram mapping type 
do not work on 16-bit images 

Fixed. The histogram equalization worked only for 
images with a dynamic range of 4096 levels. Now 
it works fine for all types of images. 

802 Bad scroll wheel step for Integer ports Fixed. The scroll wheel step was set to 10 instead 
of 1 when the port value was more than 1000. 

1144 Avizo Wind license prevent from importing Tecplot ascii files Fixed. Avizo Wind extended reader only supports 
binary format. When reading an ASCII Tecplot file, 
the Avizo Standard reader is now used, creating 
standard Avizo data objects instead of Avizo Wind 
data objects. A warning is displayed in console 
panel suggesting converting to binary format for 
taking full advantage of Avizo Wind capabilities. 

1180 VoltexHighQuality image disappears at some angles in some 
case 

This is now solved by using the new option "Use 
high precision frame buffer" added in the 
Rendering tab of the Preferences dialog 
(accessible from menu Edit>Preferences). 

1181 LatticeAccess not working on float LDA Fixed. Lattice Access on float LDA extracted 
incorrect data. 

1212 Update problems of display for data with time-step Fixed. When a transient data was loaded and a 
gridview connected (or a crosssection...), if the 
time animation was launched, the gridview was 
updated at the first time step but not after. 

1268 RemeshSurface builds surfaces that don't pass the 
Intersection test of the surface editor 

Improved. RemeshSurface now avoids 
intersection in most cases. Guidelines have also 
been added in documentation for limiting these 
issues. 

1778 Crop editor crash when applying flipz to a large volume Fixed. 

1825 Some CSV files could not be read correctly as point clusters Fixed. 

1890 AlignSlices/Landmark alignment crash AlignSlices/Landmark alignment crashed when 
triggered on a data previously aligned with 
AlignSlices 

1077 No right-click menu in full-screen mode on Windows 7, 
cannot revert to normal mode. 

Fixed. Right-click menu or F11 hotkey can be used 
for turning full-screen mode on and off. 

2501 Quantification exeCommand does not take into account 
some parameters. 

NEED REVIEWING 

1137 Quantification:convex_hull gives wrong result in some cases Fixed. 
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1176 Port interconnection not working when moving an 
orthoslice with the mouse 

Fixed. When connecting the Slice Number port of 
two OrthoSlices and when moving the slice 
position using the mouse in the 3D view, the 
connected Ortho Slices was not updated 
accordingly. 

1203 Quantification input unwanted reset Fixed. When choosing a command, the 
Quantification module no more resets input to 
previous one. 

1205 VoltexHighQuality performance issue with full optimization 
option 

Fixed. In some cases the volume rendering 
performance dropped when full optimization was 
enabled, unless lowering the video memory 
amount set in Preferences, LDA tab. 

1271 Quantification command "convex_hull" mistakenly shown as 
operating in 2D and 3D in GUI 

Now convex_hull is identified as per "XY planes" 
only. 

1326 When loading data using a PortFilename in multi-file mode, 
a file can be loaded twice in one step 

Fixed. When loading files through a PortFilename 
in multi-file mode, duplicated filenames are now 
checked. 

1377 Annotation crashes Avizo if certain TCL commands are 
entered 

Fixed. "Annotation text connect" produced a 
crash. 

1417 Empty connection for sliceNumber crash Fixed.Entering command "OrthoSlice sliceNumber 
connect" without argument was causing a crash. 

1427 Cannot load .csv file with headers and blank lines CSV reader has been fixed. 

1429 Quantification: create_measure GUI - expression functions 
do not work in 64-bit 

Fixed. Custom measure expressions with 
functions now work in 64-bit version of Avizo. 

1434 Segmentation editor: Propagating contour does not release 
memory 

Fixed. The propagating contour tool now releases 
all used memory. 

1462 Cannot start Avizo Fire as administrator Fixed. Avizo Fire could not be started correctly as 
administrator on Windows 7 in some case. 

1525 Quantification: document method used by area3d command area3d help now refers to section about Crofton 
perimeter where the equivalent method for 2D is 
detailed. 

1544 LegoSurface always create a new output upon apply LegoSurface now reuses the existing output data 
object when pressing apply, like SurfaceGen does. 

1546 Can't convert twice an images stack to LDA format, lst file 
remaining in data directory 

Fixed. LDA now creates and removes temporary 
lst file in standard temporary directory and 
doesn't require anymore write permission in 
input data directory. Since Avizo could fail 
converting because of write permission, it could 
convert actually to LDD format without warning. 

1556 Improve warning when loading compressed .am AmiraMesh 
as External Data 

Upon detecting Avizo compressed format (HxZip 
field) a new dialog displays: 
"This Avizo .am file contains ZIP compressed data 
and cannot be read as External Disk Data. For 
access as external disk data, save to .am format 
without compression, or convert to Large Disk 
Access (LDA) format."  

1557 Can't reload module network using CSV file, CSV reading 
options no scriptable 

CSV reading options are now scriptable and Avizo 
can now reload networks using CSV data other 
than default. 

1577 With Avizo Wind unstructured models, the histogram in 
Colormap editor is empty 

Colormap Editor can now display histogram of 
scalar fields from Avizo Wind unstructured 
models, in addition to Avizo hexa grids, tetra 
grids, surfaces, regular grids or images. The 
displayed histogram corresponds to the selected 
data in the colormap editor. 



 

28 
Avizo 7.0 release notes – VSG© 2011 

1583 Plot Tool window is not saved correctly in hx networks For Avizo modules that create a 2D plot window, 
if the window was moved away from its default 
location, an error appeared when reloading the 
network. Reloaded network now restores 
correctly the size and position of Plot Tool 
windows. 

1604 LDM conversion looks abnormally slow in some case, e.g. 
from 2D image stacks 

Conversion performance has been much 
improved for stacks of 2D images, in particular for 
large images. 

1621 FitleredObliqueSlice crashes with Edge Preserving Filter 
(step port) 

Fixed. User could crash Avizo by setting Edge 
Preserving filter step port to 0, for instance while 
tuning parameter with mouse wheel. Step cannot 
be set anymore below 1. 

1626 Abaqus reader crashes when adding all datasets to some 
models 

Fixed. 

1639 Quantification command help access issue - Acrobat 10 
compatibility 

Quantification command help now supports 
Acrobat Reader X. Pressing F1 or command help 
button in Quantification module did not show the 
help corresponding to selected command in 
Acrobat Reader. 

1642 Quantification module changes parameters Fixed. When choosing a command, the 
Quantification module no more resets input to 
previous one. 

1643 seqfrom3d/seqto3D issues with needless copies and 
persistence 

A new port Interpretation has been added to 
easily apply commands slice by slices (XY planes) 
or in all directions at once (3D), when applicable. 
This supersedes the seqfrom3d and seqto3d 
commands. It was not possible to save 
consistently a network that uses 
seq2D/seqfrom3D. It was often required to copy 
needlessly data from/to 3D for applying 
commands in 2D mode. 

1732 Quantification module wrong input change Fixed. When changing the name of the command 
the input changed. 

1791 ParticlePathlines doesn't display box Fixed. When active option was checked in 
"Display box" port, the box didn't appear. 

1792 SurfaceView wrong display after removal of unused points Fixed. After removing unused point from a 
surface when saving it to file, SurfaceView display 
was wrong. 

1865 Some 16 bits DICOM files cannot be read properly Fixed. The DICOM reader has been extended to 
support more format variations. 

1960 Quantification getCommand doesn't provide parameters 
anymore 

Until Avizo 6, one could get the command and 
parameters from Quantification module using TCL 
getCommand  
This didn't work anymore in 6.3.1: getCommand 
only returned the command name. 

2010 Preference 'show colormaps connected to objects’ must be 
disabled by default 

AVIZO ALL EDITIONS - USER INTERFACE 
ENHANCEMENTS 
Colormaps connected to modules are now hidden 
by default to avoid confusing the project view. 
You can enable the option "Show colormaps 
connected to objects" from menu 
View>Preferences, in Layout tab, Project View 
box. 
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2040 Quantification crashes when output name has a space 
character 

Fixed. Quantification module now prevents to 
insert whitespaces in result names. Note that 
Avizo data objects can't have a whitespace in 
their name (replaced by dash). It is however 
possible to save data to disk with whitespaces in 
file names. 

2189 Missing link to Avizo XPand reference doc AVIZO XPAND ENHANCEMENTS 
XPand menus - Programmer's Guide and 
Reference, Development Wizard, Qt Inspector 
XPand API Programmer's Reference can now be 
accessed from Avizo Help menu, in addition to 
Programmer's Guide. Do not miss also the Avizo 
Code Book, located in doc subdirectory of Avizo 
installation directory. 

2204 Adobe Reader X is not supported by Quantification module's 
'command help' button and F1 hotkey 

Fixed. 

2277 Crash with viewer seek 's' shortcut No more reproduced with Avizo 7. Avizo crashed 
when picking multiple times in viewer while 
holding "s" key pressed. 

2287 Ctrl-A key shortcut for Select All in console doesn't work Fixed. 

2299 AffineRegistration creates temporary hidden objects that 
are never deleted 

Fixed. Temporary data was not removed when 
using the "Align principal axes" option of the 
AffineRegistration module. 

2366 Crash when using TCL command 'connect' to non-existing 
object 

Fixed. In some case, using the TCL command 
"connect" with an invalid argument caused a 
crash. A message is now displayed "No object 
with name: ...". 

2389 Missing font port for DisplayDate and DisplayTime module AVIZO ALL EDITIONS - OTHER ENHANCEMENTS 
A new port is available for changing font name 
and size for Display Time and Display Date 
modules. 

2395 HeightField initial display is slow - defaults settings should 
be changed 

AVIZO ALL EDITIONS - USER INTERFACE 
ENHANCEMENTS 
Height Map Field (HeighField) default draw style 
and scale changed 
For quicker display, the default draw style for 
Height Field Map module is now shaded instead 
of outline. The default scale is now -0.05 and port 
min/max allows negative and positive scales.  

2407 Tetra quality test of surface editor doesn't provide the same 
aspect ratio on the attached surface with Avizo 6.3 and 6.3.1 

Fixed. Tetra quality test of surface editor was 
incorrect in some case in Avizo 6.3.1. 

2478 Shear module: angle cannot be greater than 40 Fixed. Shear angle is no more limited. Note that 
larger angles increase result data size. 

2617 Quantification: I_analyze error in some cases Fixed. A message "Ip function failed" appeared in 
some case at the end of processing. 

2620 Quantification:rgradient3d crashes in some cases The command rgradient3d of Quantification 
module has been fixed. 

2969 CannyEdgeDetector has a button DoIt instead of using the 
standard button Apply 

Canny Edge Detector now uses the Apply button. 

508 CalculusMatlab doesn't keep bounding box Fixed. The output of CalculusMatlab didn't have 
the same bounding box as the input. 

1036 Matlab module should output in existing result data object 
instead of creating a new one 

Fixed. When running a CalculusMatlab module 
twice, two results were generated making it 
impossible to connect the output to other 
processing modules. Now, computations are 
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performed in-place allowing to use 
CalculusMatlab in a processing chain. 

1905 ObliqueSlice can't display first slices and last slices in some 
cases 

Depending on the size of the volume, ObliqueSlice 
couldn't display first slices and last slices. 

2302 Quantification module: precision issue with 
getFieldArrayValueX 

Fixed. In some case, I_analyse results lost 
precision when retrieved by TCL script 
commands. 

2448 ObliqueSlice and other ArbitraryCut modules: bad rendering 
when the input data contains a scale. 

Fixed. When the input of an ObliqueSlice 
contained a scale, the ObliqueSlice appeared 
black as soon as it was rotated. 
This was also true for all related modules based 
on ArbitraryCut such as Isoline, Vectors, 
PlanarLIC, etc. 

 


